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Purpose of this thesis was to create a functional Microsoft Visio template and write basic 
drawing rules both for piping and instrumentation and for process flow diagram drafting for 
Evac. The template was to contain the needed drawing sheets, stencils and shapes. Also 
the necessary page settings were adjusted so that the template would work. Drawing rules 
were to be in common level and include some basic instructions on how to use Microsoft 
Visio. 
 
The template, stencils and shapes were all made by using Microsoft Visio Professional 
2013. Microsoft Visio is Microsoft’s software for diagram drafting. Diagrams created with 
Visio can illustrate different kind of processes, organization charts or even floor plans. 
 
The template is a pre-formatted file, which serves as a starting point for a new drawing. 
The template for Evac contains the needed pages, stencils and shapes. Shapes were 
made according to the chosen standards. For part of the shapes, pre-defined data were 
added. Also, tag codes were defined according to the chosen engineering numbering sys-
tem for all shapes. Shapes were created and divided into eight different stencils. Stencils 
are files that hold drawing shapes. The template contains multiple pages for different pur-
poses: front page, drawing page, revision page and several background pages. 
 
Rules and instructions were written for drawing process diagrams. Those include basic 
rules about page size, about notes and markings, process flows, flow direction, revision 
making, sheets naming, and the minimum information required in P&ID. Also some instruc-
tions on topics such as how to add data into shapes and how to insert a new page were 
written. 
 
As a result of this thesis, a working template for Visio and drawing rules were created. 
Consequently, the template can be used for drafting diagrams in Evac. 
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Tämän insinöörityön aiheena oli luoda Evacille toimiva piirustusmalli prosessikaavioiden 
piirtämiseen Microsoft Visio -ohjelmalla. Lisäksi luotiin säännöt ja käyttöohjeet prosessi-
kaavioiden piirtämiselle. Piirustusmallin oli tarkoitus sisältää tarvittavat kaavaimet, muodot 
ja sivut. Myös asetukset toteutettiin niin että, malli sopii käyttötarkoitukseensa. Sääntöjen 
ja käyttöohjeiden oli tarkoitus olla perustasoa. 
 
Tässä insinöörityössä ohjelmana käytettiin Microsoft Visiota, joka on Microsoftin ohjelma 
kaavioiden luontiin. Ohjelmalla voi luoda kaavoita, kuten prosessikaavioita, organisaa-
tiokaavioita tai vaikka pohjapiirustuksia. 
 
Piirustusmalli on valmiiksi muotoiltu tiedosto, jota voi käyttää uuden piirustuksen tekemi-
seen. Mallia varten luotiin kaavaimia ja kaavaimiin luotiin tarvittavat muodot. Muodot luotiin 
valittujen standardien mukaisesti. Muodoille myös määritettiin tunnistekoodit valitun stan-
dardin mukaan. Osaan muodoista lisättiin valmiiksi dataa. Piirustusmalliin luotiin valmiiksi 
useita sivuja: etusivu, piirustussivu, revisiosivu sekä usea taustasivu. 
 
Insinöörityössä kirjoitettiin myös säännöt ja käyttöohjeita prosessikaavioiden piirtämiseen 
Microsoft Visiolla. Säännöt olivat yksinkertaisia, kuten mitkä ovat sallitut kaavion koot, mi-
ten merkinnät tehdään kaavioihin, miten eri prosessilinjat kuvataan, miten revisiot merki-
tään ja mitkä ovat kaavioiden vähimmäistiedot. Käyttöohjeisiin kirjoitettiin ohjeita, kuten 
miten luodaan uusi sivu ja miten lisätään dataa muotoihin. 
 
Insinöörityön lopputuloksena syntyi toimiva piirustusmalli sekä kaavioiden piirtämistä tuke-
vat säännöt sekä käyttöohjeet. Piirustusmallia voidaan käyttää Evacissa prosessikaavioi-
den piirtämiseen. 
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List of Abbreviations 

CEN European Committee for Standardization. Association that brings together 

the National Standardization Bodies of 33 European countries. 

ISO International Organization for Standardization. Association that adminis-

trates international standards. 

Instance shape 

Copy of a master shape.  

Master shape 

Shape that always remains in stencil. 

P&ID Piping and instrumentation diagram. A diagram, that represents the tech-

nical realization of process by means of graphical symbols representing 

equipment and piping. 

PFD Process flow diagram. A diagram, that represents the process with the 

main process information. 

SFS Finnish Standards Association. Association that administrates Finnish 

national standards. 

SN Standards Norway. One of the three standardization bodies in Norway. 

Stencil File that hold collection of drawing shapes. 

Tag Unique identifier for component.  

Template Pre-formatted file, which serves a starting point for a new drawing. 
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1 Introduction 

1.1 Evac 

Evac was established in 1979 and is nowadays world’s leading provider of integrated 

waste, wastewater and water management systems for the marine, offshore and build-

ing industries. Evac has about 216 employees in Finland, Germany, France, China, 

Korea, USA, Brazil and Norway. Evac also has representatives and service specialists 

in over 40 countries. Evac’s headquarters is located in Espoo, Finland. [2; 3] 

Evac is concerned about the environment and therefore follows the ISO 9001 and 

14001 requirements in everyday operation. Evac’s products and processes also meet 

or exceed the IMO MEPC.159 (55) and Alaska 33CFR 159.309 regulations and Baltic 

MEPC 62 rules. [1] 

1.2 Purpose of the thesis 

This thesis had two main objectives. The first objective was to create a Microsoft Visio 

template for process diagram drawings. The second main objective was to write a 

guide on how to draw diagrams with Microsoft Visio. In this thesis, the Microsoft Visio 

Professional 2013 was used. 

The need for the Microsoft Visio template arose from the willingness to start using Mi-

crosoft Visio as a drafting program. The purpose of the template was to contain stencils 

that hold shapes made according to the chosen standards. The aim was also to define 

tag codes for the shapes according to the chosen engineering numbering system. In 

addition the template was to include pages defined in advance to make sure that the 

settings were right. 

The purpose of the drawing guide was to include basic rules about drafting and basic 

instructions on how to use Microsoft Visio. The importance of the guide was high be-

cause there was not much expertise of using the Microsoft Visio in the company. Also 

because Evac has offices and designers all around the world, the instructions helps in 

sharing information and introducing the software. 
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2 Process diagrams 

2.1 Process flow diagram 

The process flow diagram (PFD) is a diagram that represents the process and the main 

process information. The process flow diagram is needed for the making piping and 

instrumentation diagrams, for preliminary equipment and pipeline specification and for 

budget planning. The process flow diagram is needed when briefing the staff that is 

participating in a project and also in various license proposals. [4] Process flow dia-

grams are also used in marketing to give a general view of the process in the bidding 

stage. 

Chemical, mechanical and physical part processes are represented in functional order 

in process flow diagrams. Process operation is represented in stationary status at de-

sign conditions. PFD contains the following: 

 main equipment 

 equipment names, identifiers and size or capacity descriptive quantities 

 process flows 

 pipeline identifiers 

 control necessities 

 flow rate and quality of the flow substances 

 inflows and outflows of substances and energy 

 address for coming and leaving process lines 

In the creation of process flow diagram, there are a few principles that are normally 

followed. The PFD should be drawn loose enough, the direction of main process flows 

should be from left to right, the main equipment should be drawn as simply as possible, 

and, if possible, the process should be drawn in one straight vertical or horizontal line 

depending on the system. [5] 
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2.2 Piping and instrumentation diagram 

The piping and instrumentation diagram (P&ID) is based on the process flow diagram 

(PFD). P&ID represents the technical realization of the process by means of graphical 

symbols representing equipment and piping. P&ID also includes graphical symbols for 

process measurements and control functions. [5] 

Purpose of the piping and instrumentation diagram is to provide information about the 

technical solutions of the process. P&ID represents detailed paths of the pipelines in-

cluding common information about pipelines. P&ID gives data for creating a component 

list and an estimate of costs. P&ID works as an introduction to the process for design-

ers, technicians, maintenance and operators. [4] 

Piping and instrumentation diagram consist of the following items: 

 equipment 

 process lines 

 valves 

 measuring points and control functions 

 reject, cleaning and ventilation couplings 

 equipment numbers and names 

 pipeline identifiers 

 delivery lines 

 address for coming and leaving process lines. [4] 

A piping and instrumentation diagram that was drafted by using an Evac template and 

shapes is presented in Appendix 1. 
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3 Standardization and Standards 

3.1 Standardization 

Creating an agreed way to do something is called standardization. The purpose of 

standardization is simplifying how to do things. Standardization makes the authorities 

work, economic life and the consumer’s life easier. [6] 

Standardization affects the many variables. Standardization improves product compati-

bility and safety, protects consumer and the environment and makes both domestic 

and international trade easier. [6] 

Standardization makes sure that products, service and processes are suitable for in-

tended usage and circumstances. Standardization also ensures compatibility of prod-

ucts and processes and ensures that products and processes work together. [6] 

3.2 Standards 

Standards are documents that include requirements, specifications, guidelines and 

characteristics for materials, products and processes. Using standards consistently 

ensures that materials, products, processes and services are fit for their purpose. Any-

one can purchase and use standards. Purchasing standards is chargeable, but using 

and applying them is free. [7] 

A product that is manufactured according to the standards is acceptable on the global 

market. Standards remove trade barriers and make global trade easier. [7] 

There are many different kinds of standards in the world. For example paper and enve-

lope sizes, clothing and shoe sizes, food packaging and screws are based on stand-

ards. Products manufacturing, construction, installation, repairing and maintenance 

work are conducted in accordance with standards. Standards are required for using 

systems, devices and equipment, as well as for operating and maintaining them. [8] 

In some standards, the letter combination on the standard’s name tells in which organi-

zations the standard is confirmed. The letter combination SFS tells that the standard is 
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confirmed in Finland, EN means that the standard is confirmed in the European Com-

mittee for Standardization (CEN), and ISO means that the standard is confirmed in the 

International Organisation for Standardization. Every country has its letter combination 

as an identifier. [9] 

3.3 Standardization organizations 

3.3.1 Finnish Standardization Association (SFS) 

The Finnish Standardization Association is the main organization for standardization in 

Finland and, it was founded in 1924. [11] SFS is a non-government and a non-profit 

aiming organization. [10] Members of SFS are commercial and industrial organizations 

and the state of Finland. [11] 

The main task of SFS is to create, verify, publish and sell standards. Informing about 

the standards to public is also one of the main tasks of SFS. [11] SFS takes care that in 

Finland we have a collection of standards that meets the national needs. [10] 

SFS is a member of the International Organization for Standardization (ISO) and the 

European Committee for Standardization (CEN). Most of the SFS standards are based 

on European or international standards. [11] 

3.3.2 International Organization for Standardization (ISO) 

International Organization for Standardization (ISO) started its official operation on 23 

February, 1947. ISO is an independent, non-governmental international organization. 

ISO has 162 members from national standards bodies and 3368 technical bodies. The 

Central Secretariat of the ISO is based in Geneva, Switzerland. [12] 

ISO has published over 19000 international standards, and the standards covers al-

most every industry. Standards are developed voluntaries by the members of the ISO 

to support innovation and provide solutions to global challenges. [12]  
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3.3.3 Standards Norway (SN) 

Standards Norway is one of the three standardization bodies in Norway. It was founded 

on 24 June 2003. Standards Norway is a non-governmental and independent member 

organization. The organization is not responsible for standardization activities in electro 

technical field and telecommunications field. It is responsible for standardization activi-

ties in all other areas. [13] 

Standards Norway is a national member of the International Organization for Standard-

ization (ISO) and the European Committee for Standardization (CEN). [13] 

About 1200 new Norwegian Standards (NS) are published every year by Standards 

Norway (SN). At the present there are more than 15000 valid Norwegian Standards 

existing. [13] 

3.3.4 European Committee for Standardization (CEN) 

European Committee for Standardization is an association that unites the National 

Standardization bodies of the European countries. The number of the National Stand-

ardization bodies is 33. [14] 

CEN is a private and non-profit organization. CEN aims to produce high-quality stand-

ards for products and services, thus, the need of stakeholders becomes fulfilled. [15] 

The European Union and The European Free Trade Association (EFTA) has officially 

recognized CEN as an official European Standardization Organization due to being 

responsible and defining voluntary standards at the European level. [14] 

CEN closely co-operates with the International Organization for Standardization (ISO) 

and the International Electrotechnical Commission (IEC) and is committed to support-

ing the international standardization system. [15] 
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3.4 Purpose of the used standards 

The purpose of standards in this thesis was using them as a reference in stencils and 

tagging system creating. The SFS ISO-EN 10628-2:2012 and the NORSOK Z-004 

standards were used as references in the creation of stencils. The tagging system was 

created by using the Engineering Numbering System that is created by Hyundai Heavy 

Industries’ ship building division. 

3.4.1 SFS ISO-EN 10628–2:2012 

The standard SFS ISO-EN 10628-2:2012 contains the English text of the European 

standard EN ISO 10628-2:2012 Diagrams for the chemical and petrochemical industry. 

Part 2: Graphical symbols (ISO 10628-2:2012). This European standard EN ISO 

10628-2:2012 is confirmed as a Finish national standard in 21.January, 2013.  Confir-

mation for this standard is made by the Mechanical Engineering and Metals Industry 

Standardization in Finland. This standard is also approved in CEN. This standard SFS 

ISO-EN 10628-2:2012 replaces the standard SFS ISO-EN 10628:2001. [16] 

In practice this standard SFS-EN ISO 10628-2:2012 defines graphical symbols for the 

preparation of diagrams for the chemical and petrochemical industry. Symbols included 

in this standard are, for example, pumps, valves, filters, heat exchangers, compres-

sors, blowers and agitators.  [16] 

The purpose of this standard in this thesis was to use it as a reference in creating the 

needed shapes. Shapes that are made according to this standard are presented in 

Appendix 2.  

3.4.2 NORSOK Z-004 

With the support of the Norwegian Oil Industry Association (OLF) and Federation of 

Norwegian Engineering Industries (TBL), Norwegian petroleum industry has developed 

Norsok standards for petroleum industry developments and operations. [17] The pur-

pose of the Norsok standards is to ensure appropriate safety, value adding and cost 

effectiveness. The Norsok standards are administered by Standards Norway (SN). [18] 
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The purpose of the NORSOK Z-004 standard is to define drawing symbols for offshore 

engineering. The symbols of this standard are designed so that they are in compliance 

with ISO and other standards where possible. Some of the symbols are unique to the 

offshore industry. [17] Shapes created according to NORSOK Z-004 are presented in 

Appendix 3. 

3.4.3 Engineering numbering system by HHI 

The Engineering Numbering System (ENS) that is used in this thesis has been devel-

oped by Hyundai Heavy Industries (HHI) ship building division. The purpose of the 

standardised ENS is to provide abbreviated identifications and classifications for engi-

neering data such as equipment, instruments, piping, systems, documents and draw-

ings. [19] 

In this thesis the HHI Engineering Numbering System was used to define tag codes for 

the shapes. A tag code for the shapes that was found from HHI ENS is presented in 

Appendix 4. ENS does not include tag codes for all shapes, for those symbols the tag 

code was defined by me and my thesis instructor. For valves we made an exception 

and agreed that all tag codes for valves is defined to be “V”.   

4 Microsoft Visio 

Microsoft Visio is a diagram drafting software. Diagrams created with Visio can illus-

trate different kind of processes, organization charts or even floor plans. Three main 

properties have been defined for Visio. It is a supporting tool for office software, mean-

ing that diagrams with information can be created to support other documents. Visio is 

software for technical design, management and support so technical personnel can 

create diagrams from existing systems and engineer new ones. Visio can be used for 

making customized presentations; hence, unique diagrams can be created and organi-

zations can define their own standards which can be utilized with Visio. [20, p. 4]  

Using Visio with other Microsoft office programs makes presentation, document and 

table designing and execution easier. It also helps in project management. The func-

tionality of user interface can be visualized, for example, by creating hyperlinks be-

tween diagram sheets. [20, p. 4] 
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4.1 Basics 

The external look of Microsoft Visio is very similar compared to other Windows soft-

ware (Image 1). [20, p. 8] Earlier use of other Windows software definitely helps learn-

ing the basics of Visio. 

 

Image 1. Resemblance between the external look of Visio reminds and that of other Windows 
software [20, p. 8] 

In the option ribbon there are the following basic tabs: File, Home, Insert, Design, 

Data, Process, Review and View. In addition to this, there can be alternative tabs de-

pending on the diagram type. [20, p. 9] For example in, process diagrams there is Pro-

cess Engineer tab. 

General control tools such as opening a new file, saving, printing and Visio settings can 

be found from File tab. Home tab contains formatting tools for shapes and text, shapes 

alignment tools and basic tools for drawing. With the commands of the Insert tab pic-

tures, hyperlinks, comments and other objects can be added into document. The De-

sign tab holds drawing layout tools. Behind the Data tab can be found data manage-
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ment tools. The Process tab holds commands for sub processes, validity control and 

task path. The Review tab contains checking tools and, the View tab contains display 

features. [20, p. 9] 

4.2 Starting a drawing 

Before starting to draw the actual drawing, it is good to think what type of drawing is 

going to be made. When this is known, the right kind of diagram type can be chosen. 

Also page settings should be set properly so that are drawing area can be utilized as 

efficiently as possible. [20, p. 10] 

The diagram type can be selected in the opening window of Visio. Choosing the right 

diagram type helps starting the drawing. Visio contains many different diagram types 

such as block diagrams, project schedules, software diagrams, network diagrams and 

process diagrams. The diagram type affects what kind of stencils are available for cre-

ating drawings. Other stencils can still be opened. If you want to open a new diagram, 

choose File, choose New and then choose the wanted diagram type. [20, p. 10] 

After choosing the diagram type, it is recommended that page settings be adjusted. 

When adjusting the page setting, it is good to consider for which purpose the diagram 

will be used. The page setting can be accessed from the Design tab and pressing the 

Page Setup extension button (Image 2). 

 

Image 2. Page Setup extension button 
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Pressing the Page Setup extension button opens a Page Settings window. In Page 

Settings it is possible to set settings, such as printing settings, page size, drawing 

scale, page name, type and layout as well as routing settings. [20, p. 11-13]. 

4.3 Drawing tools and drawing 

Drawing tools can be found in the Tools group in the Home tab. The Tools group con-

tains tools for pointing, connecting, text, geometric shapes, lines and text rotating. By 

using these tools, it is possible to create shapes, make connections between shapes 

and write information. 

Drawing the diagram happens by choosing the wanted shape, by pressing the left 

mouse button and by dragging the shape into the drawing sheet. After releasing from 

the left mouse button the selected shape appears into the drawing sheet. After being 

added into the drawing, the shape can be moved, rotated and resized. Connections 

between shapes are made with the Connector tool. Text can be added into a shape 

by double clicking the shape or by choosing the text tool and by pressing the shape 

where text is needed. 

4.4 Benefits of Microsoft Visio for Evac 

In addition to the basic tools of Microsoft Visio, there are lot of advanced and useful 

properties in Visio. In the following chapter I will introduce some of the properties that 

are beneficial for Evac at the moment. The beneficial properties are the following: 

 Data can be added to shapes 

 Data can be exported into Microsoft Excel 

 Data can be linked from Microsoft Excel to Microsoft Visio 

 Automatic tag coding 

 Multiple design can be drafted into one drawing 

The fact that data can be added into shapes (Appendix 5) and the fact that data can be 

output to Microsoft Excel are heavily linked together. Data that is included in the 
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shapes are the data that can be output to Excel. The benefit is that when creating a 

diagram that contains data, component lists can be created more quickly and easier. 

Hence, when the data is in the diagram, it is possible to output the component list from 

Visio as an Excel sheet. Appendix 5 shows how to generate component lists in Evac. 

Linking data from Excel to Visio is a quality that is used when there is a need to link 

data (such as mass balances) to process flow diagram so that the data can be re-

freshed. This is beneficial because you need only one mass balance template and you 

can use it for every process flow diagram. 

Automatic tag coding is beneficial because it makes drawing a diagram quicker be-

cause, you do not have to add tags manually. It also prevents using wrong tag codes 

because in the Evac template the tag codes are already defined. 

Multiple designs can be drafted into one drawing by using layers. This means that 

when Evac has different standard designs from membrane bioreactors, all designs can 

be drafted into one drawing. This helps in maintaining documents. 

5 Creating the Microsoft Visio template 

One of the main priorities in this thesis was to create a complete Microsoft Visio tem-

plate for Evac. Template is a pre-formatted file, which serves a starting point for a new 

drawing. The template was supposed to include all the needed pages and stencils. It 

was also ensured that the settings of the template were right. Creating a template is 

very easy in practice. As its simplest, it can be just one blank drawing sheet and saved 

in template format (.vstx). However, the template can also be very versatile and practi-

cal with different kind of sheets, settings and stencils. Having an own standard tem-

plate makes it is easy to maintain likeness in every drawing in every project. 

5.1 Pages 

A template can contain multiple pages for different purposes. Pages that the Evac tem-

plate contains are named as front page, drawing page, revisions page and background 

page. Background page is made for different page sizes (A0 – A3). 
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Front page is a page that includes symbol and abbreviation explanations. There are 

explanations for valve shapes, pipelines, instruments, some main equipment shapes 

and a list of abbreviations (Image 3). Information in the front page can vary according 

to project needs. The idea is that only the used valve shapes and abbreviations, and 

the most used equipment shapes and the shapes that need to be explained are shown 

in the front page. 

 

Image 3. Front page example, shapes can vary according to project needs. 

The actual drawing page is a blank page where to start a drawing. The size of the 

drawing page is A3. The drawing is to be drawn to several A3 pages according to the 

process. 

The revision page includes a table for revision marking as Image 4 shows. The fields 

that revision table contains are Revision, Designer, Date and Description. This is an 

easy way to follow in which revisions the drawing has undergone and what changes 

there have been made to the drawing. A separate page for revision marks also leaves 

more space for the drawing page.  



14 

 

 

Image 4. Revision table as own page makes following in revisions easier 

The background page contains the title block. Image 5 shows that the title block con-

tains fields for inserting the name (title) and type of the drawing (PFD or P&ID), the 

designer, the approver, the date, the sheet number, the page name (drawing no.) and 

the proprietary notes. The sheet number field and Page name field are automated. The 

background page reflects to every page so all the marking that is made to background 

page appears on every page. Different page size (A0-A4) needs different background; 

therefore, there are five different backgrounds in the Evac template. 

 

Image 5. Title block 

Pages can be inserted in two ways in Visio. The first way is to go into the Insert tab 

and in the Pages group click New Page (Image 6). After clicking New Page, Visio 

gives three different options, Blank Page, Background Page and Duplicate This 

Page. Blank Page opens a new blank page with similar settings to those of the page 

that is on display. Background Page opens a Page Setup window where settings 

such as page size and name for the background can be set. Duplicate This Page du-

plicates the current page. 
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Image 6. New page can be inserted from Insert tab. 

The second way to insert a new page is to right click the Page Name ribbon. Right 

clicking the Page Name ribbon opens a shortcut menu. In the shortcut menu there are 

few different options, Insert, Delete, Rename, Duplicate, Page Settings and Reorder 

Pages. Insert opens a Page Setup where the page settings, such as page Type 

(foreground or background), Name of the page and Page Size, can be adjusted. After 

adjusting the settings right, click Ok and Visio creates new page. 

 

Image 7. New page can be inserted by right-clicking the name ribbon. 

Delete deletes the current page. Rename option allows renaming the page. Duplicate 

duplicates the current page. Page Settings opens a Page Setup window where differ-

ent settings can be adjusted. Option Reorder Pages opens a Reorder Pages window, 

where it is possible to put pages to specific order.   
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5.2 Settings 

Adjusting settings properly can make the template work better. Properly adjusted set-

tings also make drafting easier and viewing the drawings clearer. Some settings ad-

justments were made, so that the use of the template runs effortlessly. 

A background page is added to every page. The background page is part of the tem-

plate but it has to be added to every page. When background is added to every page 

already, designer does not need to pay attention to it. The designer only needs to insert 

the needed information in the title block. 

The grid is set to be shown. Grid spacing is adjusted to be 3 mm x 3 mm. Grid spacing 

can be adjusted to a desirable spacing but a 3 mm x 3 mm spacing or a 1 mm x 1 mm 

spacing is recommended. The grid makes drafting much easier. Without the grid it is 

very hard to align the equipment. 

Line jump size is adjusted to be 1 vertically and 1 horizontally. Line jump style is Arc, 

and the adding of the line jumps is set to appear on horizontal lines. With these setups 

the line jump is clear enough even with the widest lines. 

A custom equipment list has been added into Shape Reports. That is the list that is 

used when making a component list (Appendix 6). This already modified list makes 

making component lists faster and easier. 

Tag code formats are modified according to the chosen tag codes (Appendix 4) from 

HHI ENS. It is important that this setup is correct so that the right tag code appears on 

the right when a shape is added into a drawing. Tag code formatting is presented in 

Appendix 7. 

5.3 Stencils 

Visio stencils are the files that hold collections of drawing shapes. Each stencil is made 

so that the shapes have something in common. [21] Visio contains already a consider-

able number of stencils, but if some particular shapes are not found in the existing 



17 

 

stencils, creating own one’s stencils and adding shapes created by oneself into those 

stencils is a possibility. 

Stencils that are made for the Evac template contains a large number of shapes that 

are self-made with Visio. Evac template contains the following stencils: 

 Evac General Equipment (ISO) 

 Evac General Equipment (NORSOK) 

 Evac Pumps & Blowers (ISO) 

 Evac Pumps & Blowers (NORSOK) 

 Evac Instruments 

 Evac Pipelines 

 Evac Text Boxes 

 Evac Fresh Water Systems. 

Evac General Equipment (ISO & NORSOK) stencils contains basically the same 

shapes. ISO is made according to SFS-EN ISO 10628-2:2012 and NORSOK is made 

according to NORSOK Z-004. These stencils hold all the different shapes except for 

the Evac Fresh Water Systems shapes, which are made for the template. These two 

stencils hold also shapes that are not made according to the standards. That is be-

cause there were many of shapes that were wanted for the template, but those shapes 

do not exist in the used standards. Shapes included into these two stencils do not con-

tain pre-defined data. 

Evac Pumps & Blowers’ (ISO & NORSOK) stencils hold different pump and blower 

shapes. These shapes are named according to different pump and blower models that 

are often used in Evac projects. These shapes contain pre-defined data (Image 8). 
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Image 8. A shape with pre-defined data. 

Evac Instruments’ stencil holds different type of instruments. These instruments are 

named according to different instrument models that are the most used in Evac pro-

jects. These instruments contain pre-defined data (image 8). 

Evac Pipelines’ stencil holds the connectors that are modified to reflect different pro-

cess flows. These connectors have different colours and widths and are named accord-

ing to their functions of use. 

Creation of a new stencil is simple and can be done in two ways (Appendix 8). The first 

way to create a new stencil is to click More Shapes in Shapes window and clicking the 

option New Stencil (Metric) or New Stencil (US Units) from the menu that opens. The 

second way to create a new stencil is to from the Stencil group in Developer tab click 

either option New Stencil (Metric) or New Stencil (US Units). The Developer tab is 

not displayed as default. It can be added to the ribbon in Visio’s Options. The new 

stencil appears into the Shapes window named as Stencil1 if it is first one made. The 

name of the stencil can be changed by right clicking the stencil and choosing Proper-

ties. In Properties window, write the name of the stencil into the Title section. 

Stencils do not have many adjustable configurations. In the Properties window there is 

no important configurations, only the Title of the stencil. Right clicking the stencil name 

opens a floating menu. In the section View it is possible to choose how the shapes 

icons and names are shown in the stencil. In the section Order the stencils can move 
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up or down to put stencils in a desirable order. This can also be done by dragging the 

stencils in the Shapes window. 

Stencils contain an area for Quick Shapes where shapes can be added. This “Quick 

Shapes” area is located always at the top of the stencil so the shapes are always in 

top. This is a useful attribute if stencil hold lot of shapes. If there are some shapes that 

is used more frequently than others, these can be add to the “Quick Shapes” area. 

5.4 Shapes 

Shapes are the symbols for different process equipment. Microsoft Visio contains a 

large number of ready-made shapes already. These shapes are so called master 

shapes. A master shape remains always on the stencil even if you drag one onto your 

drawing page. The shape that you drag onto your drawing is called an instance, a copy 

of that master shape. Instances of the same shape can be dragged onto drawing as 

many times as wanted. [21] 

Even Microsoft Visio contains a large number of ready-made shapes, I needed to cre-

ate many of shapes (Appendix 9) by myself because the shapes needed to meet the 

requirements of standards SFS-EN ISO 10628-2:2012 or NORSOK Z-004. New master 

shapes can be created for a stencil in two different ways. 

One way to add a new master shape is to right click the stencil shape area and choose 

New Master. New Master window opens where properties can be modified such as 

Name, Prompt and Icon Size. After the properties have been set, click Ok. A new 

empty master appears into a stencil. The other way to make new a master shape is to 

copy the wanted shape from a drawing and paste it into the stencil. This way the shape 

icon appears immediately into the stencil. The master name can be changed by right 

clicking the master, choosing Edit Master and then clicking Master Properties or dou-

ble clicking the master name. 

Master shapes can be edited (Appendix 10). Right click the master, choose Edit Mas-

ter and click Edit Master Shape. A master editing window opens where the master 

shape can be edited or a completely new shape can be created. It is also possible to 

bring a shape from other sources. 
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When making a customized shape, it is important to make sure that the shape category 

and the tag format is right. The shape category and the tag format can be changed in 

Process Engineering tab. In Process Engineering tab, go to Manage group and 

click Shape Conversion. Shape Conversion window opens (image 9) and there the 

category and tag format can be changed. 

 

Image 9. Shape Conversion window 

Shapes can hold data in Microsoft Visio (Image 6). To be able to hold data, the shape 

needs data fields where to add the data. Data fields can be added into a master shape 

or into the instance of the master shape (Appendix 11). If data fields are added into the 

master shape, the same data fields appear into every instance that is made from that 

master shape. If data fields are made into an instance shape, the data fields are specif-

ic for just that shape. Data fields can be added into the master shape in the master 

editing window, whereas the data fields can be added into an instance shape by right 

clicking the shape, choosing Data and clicking Define Shape Data. 

Shapes that are modified for one’s own purposes like adding data and making custom 

tag formats are so called smart shapes. With these kinds of shapes, making diagrams 

such as piping and instrumentation diagrams is more efficient and professional. 
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6 Drafting rules 

One main priority of this thesis was to create rules for Evac’s standard products draft-

ing. The rules created for the Evac company sets the format and technical basis for 

drawing the piping, instrumentation diagrams and process flow diagrams of Evac’s 

standard products. Processes can be different such as wastewater treatment or solid 

waste handling processes. 

As design software, Evac uses Microsoft Visio and Microsoft Excel to produce process 

diagrams and component lists. 

6.1 Representation 

The representation and designation of all equipment, instrumentation and piping should 

comply with the requirements of these rules. Auxiliary systems may be represented by 

rectangular boxes with reference to separate diagrams 

The graphical symbols for process measurement and control functions for equipment, 

machinery and piping, as well as piping and valves themselves, shall be shown in the 

logical position with respect to their functions. 

6.2 Drafting 

6.2.1 General rules 

Drafting shall be in accordance with the requirements outlined in these rules. Allowable 

drawing sheet sizes are A3 – A0.The drafting must be of sufficiently high quality to 

maintain legibility when the drawing is printed to an A3 size sheet. The Evac template 

shall be used. Backgrounds shall be used on every page. 
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6.2.2 Naming of the drawing sheets 

There are two different ways to name the drawing sheets depending whether there is a 

process flow diagram sheet or not. Drawing without a process flow diagram sheet is 

named in the following way: 

 Front page: drawing number – Front page – 101 

 P&ID sheets: drawing number – P&ID – running number from 102 

If there is a process flow diagram included into a drawing, sheets are named following 

way: 

 Front page: drawing number – Front page – 101 

 PFD sheets: drawing number – PFD - 102 

 P&ID sheets: drawing number – P&ID – running number from 103 

These naming instructions shall be followed. Naming of the sheet must be done manu-

ally but the name of the sheet automatically updates to into a drawing title block, sec-

tion drawing number. 

6.2.3 Process lines and direction of flow 

Process lines in a drawing represent the substances that are flowing in a process. To 

obtain a clear representation, different line widths and colours shall be used for differ-

ent process lines. Different line widths help when viewing a drawing in greyscale, and 

different line colours help when viewing a drawing in colour. Process lines, process 

lines colours and widths are introduced in Table 1. Process line examples are present-

ed in Appendix 12.  
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Table 1. Colours, dash types and widths of a process lines 

Process line Colour Dash Type Width 

Main flow Dark blue Solid 2,5 pt 

Accommodation & Laundry grey water Black Dashed 1,25 pt 

Bio sludge / Screen Reject Brown Solid 1,25 pt 

Black water Black Solid 1,25 pt 

Food waste Orange Solid 1,25 pt 

Galley Yellow Solid 1,25 pt 

Ventilation Green Solid 1,25 pt 

Chemical Red Solid 0,25 pt 

Washing / Technical water Light blue Solid 0,25 pt 

Aeration Light blue Solid 0,25 pt 

Pneumatic Black PID Pneumatic 0,75 pt 

The direction of main flow shall be proceeding from left to right and from top to bottom. 

Other process lines such as recycling lines, chemical feeds, washing lines and tech-

nical water lines can proceed also from right to left and from bottom to top. Inlet and 

outlet arrows shall be used for indicating the inflows and outflows into and out of the 

process. 

Arrows are used to indicate the direction of the flow. Arrows are used at the inlets and 

outlets of process tanks, every time when two different process lines connect . Gen-

erally the direction of flow shall be easy to recognize. 

If a diagram consists of several sheets, the incoming and outgoing process flow lines 

on a sheet may be drawn in such a manner that the lines continue at the same level 

when the individual sheets are horizontally aligned. 

6.2.4 Notes and markings 

Markings into a drawing shall be written by using the font type Arial. The font size de-

pends on the note or marking type. Table 2 shows font sizes for different notes and 

markings. 
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Table 2. Font size and font type for markings 

Marking Font size Type 

Drawing title 12 pt Regular 

Tag for tanks 12 pt or bigger Regular 

Tag for pumps 8 pt Regular 

Tag for blowers 8 pt Regular 

Tag for valves 6 pt Regular 

Tag for instruments 6 pt Regular 

Tag for other equipment 6 pt Regular 

Tag for pipelines 6 pt Regular 

Inflow or outflow inscriptions 12 pt Bolded 

Designation of process lines minimum 10 pt Regular 

These instructions apply when the drawing size A3 is used. If the drawing size is bigger 

than A3, font sizes can be bigger. Font sizes for page sizes bigger than A3 are not de-

fined. 

6.2.5 Minimum information 

Each P&ID shall present all information as required in Table 3 during the implementa-

tion of a project in detailed design phase. The Extent of information shown on each 

P&ID in the basic design stage shall be agreed in advance. 

Table 3. Minimum information to be shown in piping and instrumentation diagrams 

Equipment Minimum Information to be shown 

Tanks Tag, Description, Nominal capacity (m3) 

Pumps Tag 

Blowers Tag 

Valves Tag 

Instrumentation Tag 

Otherequipments Tag 
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6.3 Tag codes 

The tag code is a unique identifier to a piece of equipment. Each piece of equipment 

shall be given a tag code to identify the equipment in piping and instrumentation dia-

grams. In Evac standard products tag code is formatted from the tag code (according 

to Hyundai Heavy Industries Engineering Numbering System if possible) and a running 

number beginning from 001. For example, the tag format for a centrifugal pump is as 

Image 10 shows. 

 

Image 10. Tag code format for centrifugal pump 

Microsoft Visio adds the tag code automatically when a shape is added into a drawing. 

6.4 Revisions 

The piping and instrumentation and process flow diagrams shall be revised depending 

on the type of change. In the Evac revision system, there are two different revision 

changes: minor and major (Image 11). When a major change is made to a drawing, 

such as customer interface change or major process change, the revision letter shall 

be changed. If a minor change is made to a drawing, the revision number shall be 

changed. 
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Image 11. Minor and major revision change. 

The latest revision changes shall be marked on the piping and the instrumentation dia-

grams. The revision change shall be marked by using revision cloud and revision mark 

symbols according to Image 12. 

 

Image 12. Example how to use revision cloud and mark. 

Only the latest revision marking shall be presented on the drawing, other revision mark-

ings shall be hidden. 

7 Up keeping, updating and development 

Updating and developing the Evac template and stencils became current when the first 

versions of the template and stencils were launched. We, I and my thesis instructor 

decided that I continue controlling the master files updating. I also continued develop-

ing the template and the stencils. 
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7.1 Updating 

 At the beginning updates were made almost every day. There were lots of minor is-

sues in the shapes. Most of the issues were shapes handling issues. At the beginning 

many updates were also made because some important and frequently used symbols 

were missing from the stencils. When most of the issues were solved, the updating 

frequency was decreased so that updates were made just at the end of the week. 

When the template started work as wanted and stencils hold shapes that were really 

needed, updates were made just when necessary. 

7.2 Development 

The template being functional enough, the next step is development. The main target 

of development is to make a template even more functional, to check whether there is 

something new what can be done or if something can be done in different way. Shapes 

data fields can be developed to be more accurate to their own function. Even encoding 

is a possibility because Visio drawings can contain VBA coding. Some on how to de-

velop the template, shapes, drafting rules and on how to use Visio more effectively 

have been collected into the following list: 

 Define the use of layers as drafting rules 

 learn to use data linking between Excel and Visio more deeply  

 acquire new standards 

 modify the shapes data fields to be more accurate to their own function 

In drafting rules there is no mentioning about layers. Hence, defining how to use layers 

could be smart in near future and considering if there are more benefits in using layers. 

Data linking between Excel and Visio is something that I handle somehow already. 

Learning to use the programs more deeply could be good so that the using can be 

more efficient and the benefits of it could be used. 

Acquiring new standards in the future could be one thing how to develop the template, 

shapes and drawing rules.  
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Modifying the data fields of the shapes to be more accurate to their own function could 

help the designer in drawing a diagram. It could also prevent putting data into wrong 

fields and makes working easier and more effective. 

8 Discussion 

This objective of the thesis was to create a functional Microsoft Visio template and to 

write drawing rules for both piping and instrumentation and process flow diagram draft-

ing for Evac. The template was meant to contain the needed drawing sheets, stencils 

and shapes. Also page settings should be set right. The purpose of drawing rules was 

to be at a common level and to include some basic instructions on how to use Microsoft 

Visio. 

Both objectives were successfully reached. All the needed features that template 

should contain were made successfully and drawing rules were written. Settings that 

are adjusted into the template work well, and shapes that needed to be made accord-

ing to chosen standards, have been done. All in all, the template runs very well. 

The template works so well that it can be used in drawing the piping and instrumenta-

tion- and process flow diagrams. In fact, it has been used already for a few months 

because it has worked well enough from the very first version. But it has to be remem-

bered that the template fulfils the current needs. The template can be even more func-

tional in the future; thus, its development of it has not stopped here. Also the drawing 

rules might need to be revised according to standards, such as ISO, in the future. 

I have learned a much during this thesis project. My experience about Microsoft Visio 

was almost zero before this. Hence, before I started to make anything, I needed to 

learn how to use the software and make all the needed features. Luckily, it turned out 

that learning to use Visio was not so hard. Especially, the experience about other Mi-

crosoft’s software helped because the internal interface is very similar. Also the Norsok 

standards and Engineering Numbering System were new to me; thus, this has been a 

big learning process for me. 
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All in all, I think that Microsoft Visio is a proper software for diagram drafting. With Visio 

it is possible to create professional diagrams. I think the only negative point about Visio 

is that it is not so commonly used in the world yet. 
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Appendix 1. MBR30K piping and instrumentation diagram 
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Appendix 2. Shapes according to the SFS-EN ISO 10628-2:2012 

Aeration valve  Ball valve 
 
      
 
 
 

 
Ball valve 3-way  Manual valve  

 
 
 
 
 
 

Manual valve 3-way  Needle valve 
 
 
 
 
 
 

Non return flap  Non return valve  
  

 
 
 
 
 

  
  

Reducing valve  Chemical tank 
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Process tank  Hopper tank 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Sump Tank   Centrifugal compressor 
 

  
 
 
 
 
 
 
 
 
 
 
 

 
 

Centrifugal pump  Ejector 
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Fan   Liquid ring helical screw pump 
 

 
 
 
 
 
 
 
 

Membrane pump  Piston pump 
 
 
 
 
 
 
 
 

 
 

Rotary lobe pump  Screw pump 
 
 
 
 
 
 
 
 

 
Side channel blower  Vacuum pump 
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Bulk filter    Cartridge filter 
 
 
 
 
 
 
 
 
 
 
 

 
Compensator  CRT 

 
 
 
 
 
 

 
Filter   Flanges 

 
 
 
 
 
 
 

 
 

Funnel   Heat Exchanger 
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Manway   Mixing tube   
 

 
 
 
 
 
 

 
Mixer   Reducer 

 
 
 
 
 
 
 
  

 
Rupture disc  Screw conveyer 

 
 
 
 
 
 
 

 
 

Sight glass   Sludge spraying system  
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Appendix 3. Shapes according to NORSOK Z-004 

Ball valve (V)  Diaphragm valve (V) 
 

 
 
 
 

 
Needle valve (V)  Non-Return valve (V) 

 
 
 
 
 
 

 
Centrifugal pump (PA)  Centrifugal compressor (KA) 

 
 
 
 
 
 
 
 
 
 

 
Ejector (CQ)  Membrane pump (PF) 
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Piston pump (PB)  Rotary lobe pump (PC) 
 
 
 
 
 
 
 
 

 
Side channel blower (KF) Screw pump (PG) 

 
 
 
 
 
 
 
 
 
 

 
Air nozzle   Flanges 

 
 
 
 
 
 

Flow indicator (FI)  Flow indicator transmitter 
 
 
 
 
 
 

 
Instrument   Mixer (CJ) 
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Manway   Reducer 
 
 
 
 
 
 

 
Rupture disc (PSE)  Screw conveyer (NC) 

 
 
 
 
 
 

 
Throttling washer (GR)  Y-Strainer 
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Appendix 4. Tag codes according to HHI Engineering Numbering System: 

Equipment 

CA – Regenerative filters 

CJ – Mixer/Agitators 

EC – Control Equipment 

FE – Electric heater 

HA – Shell and Tube Heat Exchangers 

KA – Centrifugal Compressors 

KE – Fans 

KF – Blowers 

NC – Screw Conveyors 

NX – Other Solids Mechanical Equipment 

NZ – Other Solid Mechanical Equipment Packages 

PA – Centrifugal Pumps 

PB – Reciprocating Pumps 

PC – Rotary Pumps 

PE – Gear Pumps 

PF – Diaphragm Pumps 

PG – Screw Pumps 

PX – Other Pumps 

TE – Hoppers 

TG – Sumps 

TK – Containers 

TX – Other Tanks/Containment Equipment 
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Appendix. 4 Tag codes according to HHI Engineering Numbering System: 

Instruments 

FI – Flow Indicator 

FIT – Flow Indicating Transmitter 

FT – Flow Transmitter 

LI – Level Indicator 

LS – Level Switch 

LSH – Level Switch, High 

LSHH – Level Switch, High-High 

LSL – Level Switch, Low 

LSLL – Level Switch, Low-Low 

PC – Pressure Controller 

PI – Pressure Indicator 

PIC – Pressure Indicating Controller 

PG – Pressure Gauge 

TI – Temperature Indicator 
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Appendix 5. How to add data into shapes 

1. Right-click a shape, go to “Data” and click “Shape Data”. 

 

2. The Shape Data window opens and data can be inserted into a shape 
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3. Close the Shape Data window
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Appendix 6. How to generate component list 

This is instruction how to generate component list in Evac. First step in generating the 

component list is to go into ”Review” tab and clicking “Shape Reports” from ”Reports” 

group. “Reports” window opens. Choose the “Evac Equipment List” and click “Run”. 

 

After clicking the “Run”, “Run Report” window opens. In “Run Report” window the for-

mat of the report is chosen. Choose Excel and click “Ok”. 
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After clicking “Ok”, Visio generates the component list and opens it in Excel. 
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Appendix 7. Tag code formatting 

Tag code can be formatted in “Process Engineering” tab. In “Process Engineering” tab, 

go to “Manage” group and click “Edit Tag Format”. “Edit Tag Formats” menu opens, 

where tag code can be formatted. 

 

In “Edit Tag Formats” menu there are 4 different options; “Add”, “Rename”, “Delete” 

and “Modify”. “Rename” option allows renaming the tag format name. “Delete” option 

deletes the tag format. “Modify” option allows modifying the tag format and “Add” allows 

to add new tag format. Clicking the “Add” options opens a “Add Tag Format” menu 

where new tag formats can be created. In creating a new tag format, it is possible to 

use existing tag format or make a completely new tag format. 
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After making the new tag format, it can be edited by clicking the “Modify” option in “Edit 

Tag Formats” menu” (Image 1.). “Tag Format Properties” menu opens. 

 

In “Tag Format Properties” menu, it is possible to add available shape data properties 

into the tag format. Also counter can be added and counter format can be chose. To 

the “Tag expression” field it is possible to write anything that is needed to make tag 
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format look like wanted. In the top right corner there is a “Sample tag value” what 

shows what kind of looking the tag format will be. 
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Appendix 8. How to create a stencil 

There are two ways to create a new stencil. First way create a new stencil is to from 

“Stencil” group” in “Developer” tab click either option “New Stencil (Metric)” or “New 

Stencil (US Units)”. “Developer” tab is not displayed as default. It can be added to rib-

bon from Visio’s “Options”. 

 

Second way to create a new stencil is to click “More Shapes” in “Shapes” window and 

clicking the option “New Stencil (Metric)” or “New Stencil (US Units)”from the menu that 

opens. 
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Stencil properties can be changed by right clicking the stencil and choosing 

“Properties”. Stencil “Properties” menu opens where properties such as “Title”, 

“Subject”, “Author”, “Manager” and “Company” can be define. 
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Right clicking the stencil name opens a floating menu. In section “View” it is possible to 

choose how the shapes icons and names are showing in stencil. In section “Order” the 

stencils can move up or down to put stencils in desirable order. 
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Appendix 9. Creating a master shape 

One way to add new master shape is right click the stencil shape area and choose 

“New Master”. 

 

“New Master” window opens where properties can be modified such as “Name”, 

“Prompt” and “Icon Size”. After when properties are set, click ok. 
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After clicking “Ok”, a new empty master appears into a stencil. 

 

The other way to make a new master shape is to drag shape from the drawing sheet 

into the stencil shape area. 
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After dragging the shape into the stencils shape area, it appears to there as a master 

shape. 

 

 

Master name can be changed by double clicking the name. Master properties can be 

changed by right clicking the master, choosing “Edit Master” and selecting “Master 

Properties”. 
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Appendix 10. Editing the master shape 

Master shapes can be edited. Right click the master, choose “Edit Master” and click 

“Edit Master Shape”. 

 

Master editing window opens where master shape can be edited or completely new 

shape can be created. 
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In the master editing window a completely new master shape can be created by using 

the Visio’s drawing tools or edit shape that exist in Visio, just drag the shape into the 

editing window and edit it. After editing the shape, close the window and the shape 

appear into the stencil. 
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Appendix 11. How to add data fields into shapes 

Data fields can be added into master shape in the master editing window (Appendix 

10) by right clicking the shape, choosing “Data” and clicking “Define Shape Data”. Into 

an instance shape, the data fields can be added same way. 

 

Clicking the “Define Shape Data” opens “Define Shape Data” window, where shape 

data properties can be set. Click “New” to add new data fields. When needed data 

fields are made, click “Ok” to close the window.  
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After clicking “Ok”, the added data fields appear into the shape. 

 

Now data can be added into the shape (Appendix 5). 
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Appendix 12. Process lines 

 Main flow   Biosludge/Screen Reject 
 Color: Dark blue  Color: Brown 
 (R 0, G 32, B 96)  (R 156, G 75, B 9) 
 
   
  
 Ventilation   Foodwaste 
 Color: Green  Color: Orange 
 (R 0, G 176, B 80)  (R 234, G 112, B 14) 
 
   
  
 Blackwater   Accomodation / Laundry GW 
 Color: Black   Color; Black dashed 
 R 0, G 0, B 0)  (R 0, G 0, B 0) 

   
  
 Aeration   Galley 
 Color: Light blue  Color: Yellow 
 (R 0, G 176, B 240)  (R 255, G 220, B 0) 

  

 Washing   Chemical 
 Color: Light blue  Color: Red 
 (R 0, G 176, B 240)  (R 255, G 0, B 0) 

  

 Pneumatic   General line 
 Color: Black   Color: Black 
 Type: PID Pneumatic  (R 0, G 0, B 0) 
 

   


